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This technical note describes the backup and recovery procedure support
for Microsoft Exchange 2010.
A fully integrated Microsoft Exchange 2010 backup solution is currently
being developed for the next major release of the NetWorker Module for
Microsoft Applications (NMM) software. This technical note outlines a
solution that consists of a single new client binary that has been
developed.
This document contains the following sections:
•

Updates to the nsr_exchange2010 binary

•

Microsoft Exchange 2010 backups with NetWorker

•

Limitations in backing up Microsoft Exchange 2010 data

•

Backing up Microsoft Exchange 2010 data with NetWorker

•

Restoring Microsoft Exchange 2010 data with NetWorker
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The nsr_exchange2010 binary, version 1.1
The following feature support has been added for the nsr_exchange2010.exe binary, version 1.1:
•

Support for incremental backups

•

Enhanced logging and diagnostics

•

Changes to the format of the save set name. The save set no longer references the drive letter where
the original files resided. The new format is:
Exchange_Snap_<date>-<time>-<pid>

To determine which version of the nsr_exchange2010.exe binary that is currently installed on your
Exchange 2010 server:
1. In Windows Explorer, navigate to the following location:
C:\Program Files\Legato\nsr\bin
2. Right mouse click the following file:
nsr_exchange2010.exe
3. Select Properties and then click the Versions tab.
4. The latest file version of the binary is 1.1.xxx.0
Note: The download details for the new binary are discussed later in this technical note.

The nsr_exchange2010 binary, version 1.0
The initial version of the nsr_exchange2010 binary introduces the following feature support:
•

VSS-based full backups for Microsoft Exchange Server 2010

•

Microsoft Exchange log truncation

•

Stand-alone, DAG Active Node, and DAG Passive Node backups

•

Microsoft Exchange Database Recoveries in the case of database loss and corruption

•

Mailbox level recoveries using Recovery Databases and Microsoft Exchange tools

•

Target and source based deduplication

Updates to the nsr_exchange2010 binary
In order to allow EMC to proactively notify customers of any updates to the nsr_exchange2010.exe binary
or new developments for the Microsoft Exchange 2010 backup solution, send an email to:
nw_exchange2010@emc.com.
Include the following information:
•

Site ID

•

Company Name

•

Contact Name
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•

Contact Email Address

•

Contact Phone Number

In addition to this technical note, the NetWorker Procedure Generator provides detailed backup and
recovery procedure support instructions for Microsoft Exchange 2010.

Microsoft Exchange 2010 backups with NetWorker
IMPORTANT: This client binary requires that the NetWorker client software be installed on the Microsoft
Exchange 2010 system.
When Microsoft Exchange 2010 support is offered in the next major release of the NetWorker Module for
Microsoft Applications (NMM) software, it is strongly recommended that this interim solution be
immediately replaced with the new NMM solution.
This section outlines the basic backup workflow for this solution:
1. The system checks for all databases in the site and databases that have been specified for backup.
Databases that meet the following criteria are excluded from the backup:
•

Databases that have been marked by the Microsoft Exchange 2010 system as having a backup in
progress.

•

Databases that are not in a healthy state.

•

Recovery Databases (RDB).

•

Databases that do not have a valid copy on this system.

2. The VSS Writer uses the Microsoft Windows VSS framework with Microsoft Exchange 2010 to create
a volume snapshot of the required volumes.
IMPORTANT: This solution only supports the use of the default Microsoft Software Shadow Copy
provider VSS provider:
1. Remove all other VSS providers, such as the following:
 Symantec VSS Provider
 EMC VSS Hardware Provider
 NetApp VSS Hardware Provider
2. To check the VSS providers that are installed on the system, use the following command:
vssadmin list providers
3. By default, the backup solution invokes the system to perform internal Microsoft Exchange database
consistency checks prior to the backup. If the consistency check fails, the backup is aborted and is
marked as failed.
To disable the consistency check, use the following switch when the backup command is configured:
-nocheck
4. The NetWorker client performs the backup.
5. The backup status is reported to the native Microsoft Exchange 2010 VSS writer.
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6. Upon successful backup, Microsoft Exchange performs a transaction log truncation. If the backup
fails, the logs are not truncated.
7. All backup steps are logged and reported in the savegroup completion report of the NetWorker server.

Limitations in backing up Microsoft Exchange 2010 data
The following limitation applies to Microsoft Exchange 2010 backups with the NetWorker software:
Note: Only full and incremental Microsoft Exchange backups are supported. Differential backups are not
supported.
Aborting a backup in progress by attempting to stop a savegroup might fail:
•

If the savegroup cannot be stopped, on the Microsoft Exchange 2010 client machine in the Process
Manager, stop the save.exe process.

•

If the save process does not exist in the Process Manager, stop the diskshadow.exe process. The
diskshadow.exe process will restart automatically when required.

Note: Do not stop the nsr_exchange2010.exe process as it might prevent VSS snap cleanups from
occurring.

Logging
The following logging considerations apply:
•

In the nsr_exchange2010 version 1.1 binary, successful backups are now also logged to the client
Application Event Log file.

•

In the nsr_exchange2010 version 1.0 binary, all of the logging of the backup is done on the server.
For example, savegroup log files and daemon.raw.

Microsoft Exchange 2010 backup limitations
When configuring selected Microsoft Exchange 2010 databases for backup, take note of the following
Microsoft Exchange 2010 VSS Writer limitations:
•

Defining individual databases for backup on Windows 2008 R2 on page 5

•

Defining individual volumes on Windows 2008 R2 on page 5

Note: On Windows 2002 SP2, you can only backup all of the databases on the Microsoft Exchange
server. Defining the save set per volume or per database to achieve parallel backup savestreams is not
supported. Specifying an individual save set or volumes in the Save set field will result in an error during
the backup.
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Defining individual databases for backup on Windows 2008 R2
Defining multiple databases in the client save set field provides the ability to take advantage of concurrent
savestreams to reduce back times. The maximum number of concurrent or parallel savestreams for a
Microsoft Exchange client is defined by the parallelism value for the client and is addressed later in this
procedure. In order to take advantage of parallel savestreams, each database (edb and logs files) must
reside on its own dedicated volumes or LUN(s) as recommended by Microsoft:
http://technet.microsoft.com/en-us/library/ee832794.aspx
If the defined databases share the same volume or LUN, do not use parallel save streams. In this
situation:
•

Set the client parallelism of the NetWorker client to 1.
Or

•

Configure the system to backup all databases. How to configure a backup of all of the databases
provides detailed instructions.

Defining individual volumes on Windows 2008 R2
To reduce backup time and to take advantage of concurrent savestreams, you can define multiple
volumes in the client save set field. The maximum number of concurrent or parallel save streams for a
Microsoft Exchange client is defined by the parallelism value for the client.
In the case where multiple databases reside on the same volume, consider the following limitations:
•

If multiple databases reside on the same volume, multiple volumes can be backed up concurrently.
However, the databases on each volume will be saved sequentially.

•

If the database and transaction log files are cross hosted on volumes by volume, backups are not
supported and should not be configured. For example, the log file for database db1 resides on the
same volume as the edb file for database db2.
In this case, perform either of the following operations:
•

Configure the system. How to configure a backup of all of the databases provides detailed
instructions.
Or

•
•

Limit the client parallelism value for the NetWorker client created for the Microsoft Exchange 2010
backup to 1.

Active and passive database types make use of different components of the same VSS parent writer
to perform a backup. If a volume contains both an active and a passive database, this applies to either
the database location or the log location, the backup must be limited to either the active or the passive
databases.
To limit the backup to either the active or the passive databases, use the following switches in the
backup command:
•

–active

•

–passive
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Backup performance
If previously generated transaction logs have not been purged for a long period of time, the first backup of
the Microsoft Exchange database can take a significant amount of time.
Microsoft Exchange databases with high change rates generate a large number of transaction logs which
negatively affects backup performance.

Backing up Microsoft Exchange 2010 data with NetWorker
To backup Microsoft Exchange 2010 data, perform these steps:
•

Task 1: Ensure that the NetWorker software has been installed on page 6

•

Task 2: Copy the backup executable file on page 6

•

Task 3: Ensure that the Microsoft Exchange 2010 client has been configured on the NetWorker server
on page 6

•

Task 4: Customize the Save set field on page 7

•

Task 5: Customize the Backup command field on page 9

•

Task 6: Select the backup level on page 11

•

Task 7: Consider Transaction Log truncation on page 12

•

Task 8: Monitor the backup on page 13

Task 1: Ensure that the NetWorker software has been installed
The NetWorker Installation Guide provides detailed instructions on how to install the NetWorker software.
For Microsoft Windows Server 2008 R2 environments, ensure that the NetWorker client release 7.5 SP2
or later has been installed.

Task 2: Copy the backup executable file
When the NetWorker software installation is complete, the application binary that performs the Microsoft
Exchange backup must be copied to the Microsoft Exchange server.
On the Microsoft Exchange 2010 client machine:
1. Download and save the nsr_exchange2010.exe from either of the following locations:
•

http://powerlink.emc.com/km/live1/en_US/Offering_Technical/Technical_Documentation
/nsr_exchange2010.exe

•

ftp.legato.com/pub/NetWorker/Updates/Exchange2010
Note: On the ftp.legato.com site, login as anonymous.

2. Copy the nsr_exchange2010.exe file to the NetWorker software bin directory. For example:
C:\Program Files\Legato\nsr\bin
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Note: If version 1.0 of the nsr_exchange2010.exe binary is already present in the bin directory, rename
the nsr_exchange2010.exe binary before copying the downloaded binary.

Task 3: Ensure that the Microsoft Exchange 2010 client has been
configured on the NetWorker server
The NetWorker 7.5 Administration Guide provides detailed instructions on how configure backup clients.

Task 4: Customize the Save set field
You can customize the entries in the client Save set field:
•

How to configure a backup of all of the databases on page 7

•

How to configure a backup per individual databases on page 7

•

How to configure a backup per volumes on page 8

How to configure a backup of all of the databases
To customize the client Save set field:
1. Right-click the Microsoft Exchange 2010 client in the NMC window.
2. Select Properties.
3. In the Save set field, specify:
APPLICATIONS:\Microsoft Exchange 2010
Note: While a volume snapshot operation is performed for all volumes simultaneously, the backup
operation is performed sequentially. Each database is saved after the completion of the previous one.
To achieve higher performance using parallel backups, see the following sections:
•

How to configure a backup per individual databases on page 7

•

How to configure a backup per volumes on page 8

To achieve higher performance using parallel backups when the Microsoft Exchange LUN architecture as
been configured, refer to the Microsoft Best Practices available at:
http://technet.microsoft.com/en-us/library/ee832794.aspx

How to configure a backup per individual databases
Note: Individual databases on Windows 2008 R2 can only be backed up. This is not supported on
Windows 2008 SP2.
In this configuration:
•

Each database including its log files is treated separately without impact on other parallel sessions.

•

A backup failure on one database does not impact backups of other parallel databases.

•

Transaction logs are truncated for all successful backups and skipped for failed ones.
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To customize the Client save set field:
1. Right-click the Microsoft Exchange 2010 client in the NMC window and then select Properties.
2. In the Save set field specify:
APPLICATIONS:\Microsoft Exchange 2010\database_name
Where database_name specifies the dataabase to be backed up on the Microsoft Exchange server.
The volume snapshot is performed for the volume where the database and the log files reside. The
backup operation is performed for specified databases only.
3. To perform parallel backups, list multiple save sets in the Client resource. For example:
APPLICATIONS:\Microsoft Exchange 2010\DB-Store-01
APPLICATIONS:\Microsoft Exchange 2010\DB-Store-02
APPLICATIONS:\Microsoft Exchange 2010\DB-Store-03
4. Select Globals (1 of 2). By default, clients are configured with a parallelism value of 4. This allows a
maximum of 4 simultaneous savestreams to be backed up at once.
a. If multiple databases reside on the same volume/LUN set the parallelism value to 1.
b. If multiple databases do not reside on the same volume/LUN, set the parallelism value to suit your
backup environment. If greater than 4 simultaneous save streams are required, refer to the
NetWorker Performance Optimization Planning Guide. This guide describes how to tune the client
parallelism values to suit the backup environment.
Note: If the Microsoft Exchange 2010 client is also an Avamar client, the maximum supported
parallelism is 4.

How to configure a backup per volumes
Note: You can only backup volumes on Windows 2008 R2. This is not supported on Windows 2008 SP2.
In this configuration:
•

Each volume that hosts a database is treated separately without impact on other parallel sessions.

•

Only volumes that host a database should be entered as save sets. Volumes that host database log
files are automatically discovered and are included.

•

Backup failure on one database does not impact backups of other parallel databases.

•

Transaction logs are truncated for all successful backups and skipped for failed ones.

To customize the Client save set field:
1. Right-click the Microsoft Exchange 2010 client in the NMC window and then select Properties.
2. In the Save set field specify:
APPLICATIONS:\Microsoft Exchange 2010\volume:
Where volume specifies the volume on the Microsoft Exchange server with the Microsoft Exchange
databases that are to be backed up.
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If the Microsoft Exchange log files reside on a separate volume, the volume snapshot is performed
simultaneously for the specified volume and all of the dependent volumes. The backup operation,
however, is sequential. Each database on each specified volume is saved after the completion of the
previous one.
3. To perform parallel volume backups, list multiple volumes in the Save set field in the client resource.
This allows one database on each volume to be backed up at the same time as one database on the
other defined volumes.
For example:
APPLICATIONS:\Microsoft Exchange 2010\D:
APPLICATIONS:\Microsoft Exchange 2010\E:
APPLICATIONS:\Microsoft Exchange 2010\F:
4. Select Globals (1 of 2). By default, clients are configured with a parallelism value of 4. This allows a
maximum of 4 simultaneous save streams to be backed up at once.
a. If the database and transaction log files are cross hosted on volumes, set the parallelism value to
1.
b. If the database and transaction log files are not cross hosted on the volumes, set the parallelism
value to suit your backup environment. If greater than 4 simultaneous save streams are required,
refer to the NetWorker Performance Optimization Planning Guide. This guide describes how to
tune the client parallelism values to suit the backup environment.
Note: If the Microsoft Exchange 2010 client is also an Avamar client, the maximum supported
parallelism is 4.

Task 5: Customize the Backup command field
By default, the backup of all healthy and mounted databases on the system are attempted regardless of
their ownership. In the case of replicated systems, this includes both active and passive replicated
databases. Although not considered a best practice, if a volume or LUN contains both active and passive
databases and log files, only one database type and its log files which are determined by the OS, will be
saved. If the active database and the log files reside on a different volume or LUN, then the passive
database and the log files, both active and passive databases, as well as the associated log files, are
backed up.
Note: If a volume contains both active and passive databases for both the database and the log file
locations on Windows 2008 SP2, only one database which is determined by the OS, will be saved.
Backups cannot be configured to control the active or the passive database.

Optional switches
To customize the backup command of the client:
1. Click Apps and Modules.
2. In the Backup Command field, specify the following: nsr_exchange2010 <optional switches>
Table 1: Windows 2008 R2 Optional Switches and Table 2: Windows 2008 R2 Additional Optional
Switches provides details on the optional switches.
Microsoft Exchange 2010 backup and recovery procedure support with EMC NetWorker
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3. Click Ok.
This table lists additional switches for the nsr_exchange2010 backup command:
Switch

Definition/ Usage

-v

Verbose mode level 1.
Increases the reporting verbosity and includes status messages for each backup step.

-vv

Verbose mode level 2.
Increases reporting verbosity and includes detailed job output and temporary file content.

-vvv

Verbose mode level 3.
Enables maximum reporting verbosity and includes the following information:
• Detailed Microsoft Exchange 2010 server and database status for all of the servers within the site.
• Includes Microsoft Windows VSS writer status for all of the writers available on the system.
• Performs the save opreration in verbose mode.
This flag can result in a very large output and should be used for diagnostic purposes only.

-nocheck

Skip Microsoft Exchange 2010 database consistency checks prior to the backup. This option is not
enabled by default.
To disable the Microsoft Exchange 2010 database consistency checks, ensure that the Enable 24x7
ESE Database Scan (Background Database Maintenance) attribute for Public and Mailbox
Databases in Microsoft Exchange has been enabled. This option is enabled by default.
Note: Skipping explicit database consistency checks during a backup operation increases the backup
performance and also reduces the system load during the backup.

-rdb

Recovery Database
Include Microsoft Exchange recovery databases in the selection process. By default, recovery
databases are skipped.

-p

Pretend
No snapshot or backup operations are invoked.
Note: Used only for debugging purposes.

Table 1: Optional Switches

Windows 2008 R2 additional optional switches
This table lists the additional switches that are only available for Windows 2008 R2:
Switch

Definition/ Usage

-passive

Applies to DAG configurations only.
Skip active databases when performing selection process. By default, active databases are included.

-active

Applies to DAG configurations only.
Skip passive databases copies when performing selection process. By default, databases copies are
included.

Table 2: Windows 2008 R2 Additional Optional Switches

To control whether the active or the passive databases that are present on the system will be saved,
specify either of the following switches:
•

–active (no passive databases)

•

–passive (no active database)
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Note: All of the databases and the log files will be backed up if the:
• Active and passive databases and the log files are on separate volumes or LUNs.
• –active switch or the –passive switch is not used.
If both active and passive database backups are required:
1. Create one instance of the client with the –active switch.
2. Create another instance of the client with the –passive switch.
Note: Passive copy can be behind in time compared to production, by design in the case of lagged copy
configuration, due to suspended replication, or due to slow network.
To determine the amount of time the passive database copy is behind the active database instance:
1. Run following command from the Exchange Management Shell:
Get-MailboxDatabaseCopyStatus -ConnectionStatus | Format-List
2. For each database, inspect the LastCopiedLogTime property. The LastCopiedLogTime property
in only populated for passive copies.

Task 6: Select the backup level
The backup level is determined by the level of the NetWorker client or group. The backup level can be
defined explicitly or through the schedule. No special configuration is required.
Backup levels:
•

Full backup – A full backup consists of a full Microsoft Exchange database backup, a checkpoint file
backup, and a backup of all of the present transaction logs. The backup is followed by a request to
purge the transaction logs.

•

Incremental backup – An incremental backup consists of only a Microsoft Exchange 2010 transaction
log backup which is followed by request for a transaction log purge.

•

Skip – The backup is skipped.

•

* – All other backup levels (1-7) result in a full backup operation.

Incremental Backups
The following facts apply to incremental backups:
•

If the Microsoft Exchange circular logging attribute is enabled, the backup level is upgraded from an
incremental backup to a full backup and a warning is printed.

•

Each backup operation creates a checkpoint file in the same location and name as the Microsoft
Exchange checkpoint file. However, the .nsr extension is added. This checkpoint file logs the backup
times and it also provides transaction log tracing. The checkpoint file is analyzed when the backup
begins and is compared to the current system state to determine if an incremental backup can be
safely performed. If the NetWorker backup checkpoint file is not found on the client, the backup level
is upgraded from an incremental backup to a full backup and a warning is printed.
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•

A request for an incremental backup checks the logged state of the last successful full backup, last
incremental backup (if any), and also checks for the presence of all of the required transaction logs
since then. If any of the required transaction logs are missing, a warning is printed and the backup
level is upgraded from an incremental backup to a full backup.

•

Exchange 2010 Server uses fixed-size 1 MB transaction logs, so any new mail items that are not yet
flushed to disk are not included in incremental backup.

Note: Since standard Microsoft Exchange rules apply for transaction log truncation, some overlapping
transaction logs might be found in multiple backup sets. This occurs because Microsoft Exchange does
not truncate all of the logs immediately after the backup.

Backup dependencies
Consider the following backup dependencies:
•

Standard NetWorker backup dependency rules apply to Microsoft Exchange 2010 backups. For
example, if a full backup that is required by a later incremental backup is beyond its retention policy,
the volume will not become recyclable until all of the dependent incremental backups expire.

•

Per-database backup configuration is required for dependency tracking. If not, multiple database
backups will have the same name in the NetWorker media database which will interfere with the
checks that the NetWorker server performs.

Task 7: Consider Transaction Log truncation
The Microsoft Exchange application performs the actual truncation operation which is separate from the
backup process. The backup process only notifies the Microsoft Exchange Replication service that the
logs should be truncated.
When transaction logs are truncated, consider the following:
For standalone databases:
•

In order for truncation to occur, the backup must successfully complete.

•

Truncation will occur only to transaction loads that are no longer required.

•

Logs that are internally required by the currently running instances will not be truncated.

For DAG replicated configurations:
•

Log truncation will be delayed until all of the necessary log files are replayed into all of the other
copies.

•

The Replication service will delete the backed up log files from both the active and the copy log file
paths. This occurs after it verifies that the log files that are to be deleted have been successfully
applied to the copy database.

IMPORTANT: It is recommended to perform the backup from the copy, not from the active database. If a
backup is performed on the active database, the Microsoft Exchange Replication service might not be
able to verify the pending log shipment requirements and might skip the log truncation. This is a limitation
of Microsoft Exchange 2010. http://technet.microsoft.com/en-us/library/dd335087.aspx provides more
information.
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Task 8: Monitor the backup
Each backup can be monitored from the NetWorker Management Console (NMC).
Note: Selecting the save group completion details in NMC often does not display all of the data because
the number of text lines allowed in the NMC group details is limited (savegroup suppression). This will limit
the output details when backups are run with the verbose option.
The save set-specific logs are stored on the NetWorker backup server in:
nsr\tmp\sg\<savegroup_name>\*
All successful backups are logged in client's Windows Application Event Log window.

Restoring Microsoft Exchange 2010 data with NetWorker
When restoring from a Microsoft Exchange 2010 backup, you can use the NetWorker User program to
mark multiple databases and log files for restore. However, the multiple databases and log files will be
recovered sequentially.
To recover multiple databases in parallel, open multiple instances of the NetWorker User program and
mark a different database and its log files for recovery in each instance. The following procedure outlines
the steps to recover multiple databases in the same NetWorker User instance (sequential restore).
This section outlines how to perform a browseable recovery and includes the following sections:
•

Overview on page 13

•

How to recover a single mailbox on page 14

•

How to perform a standalone server recovery (overwrite the original database) on page 20

•

How to perform a DAG recovery (overwrite the original database) on page 25

Overview
Currently, the only method to restore an Exchange 2010 backup is through a browseable restore. Save
set recoveries are not supported.
When performing a browseable restore, the edb, log and chk directories are all contained in a directory in
the NetWorker User Recover window prefixed with the following:
Exchange_Snap_<date>-<time>-<pid>
For example, a database residing on the G volume backed up on April 7, 2010 appears as a folder
named:
Exchange_Snap_07042010-0632-0486
When performing a save set or browseable restore, the files must be recovered using the Relocation
option to either:
•

Restore to the original file location — The original database must be first unmounted to allow it to be
overwritten.

•

Restore to a new location — Can be used as a newly created database or accessed as a Microsoft
Exchange Recovery Database (RDB) for the purpose of mailbox recovery.
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Note: Restoring a public folder database using RDB is not supported. http://technet.microsoft.com/enus/library/ee332351.aspx provides details on how to use RDB.

How to recover a single mailbox
To recover a single mailbox, perform these tasks:
•

Task 1: Use the NetWorker User program to restore the database on page 14

•

Task 2: Perform a point-in-time or an incremental restore on page 14

•

Task 3: Extract the mailbox from the database on page 17

Task 1: Use the NetWorker User program to restore the database
To restore the database:
1. Login to the Microsoft Exchange server with an account that has Organization Management rights in
Microsoft Exchange 2010.
Note: By default, the account that installed Microsoft Exchange 2010 is given Organization
Management rights. http://technet.microsoft.com/en-us/library/dd335087.aspx provides more
information.
2. Open the NetWorker User program on the Microsoft Exchange 2010 server:
3. Connect to the appropriate NetWorker server.
4. Click Recover.
5. Select the source client which is the Microsoft Exchange 2010 server and then click Ok.
6. Select the destination client which is the Microsoft Exchange 2010 server and then click Ok.
7. From the Options menu, select Recover Options.
8. In the Relocate recovered data to field:
a. Type the original directory of the Microsoft Exchange 2010.
b. If required, select Browse to navigate to the folder.

Task 2: Perform a point-in-time or an incremental restore
This section explains how to:
•

Restore from full backup on page 15

•

Restore from Incremental backups on page 16

•

Restore additional transaction log backups on page 17

•

Restore from the last full backup on page 17
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When restoring data from the NetWorker User program, by default, the last backup instances of the
databases and logs are shown:
•

If a point-in-time restore operation, or a restore from an incremental backup is required, the browse
time must be changed to mark the previous backup version.

•

If a point-in-time, or an incremental restore is required, refer to the following sections which outline
how to restore the full database (including associated transaction log files) and the subsequent
incremental transaction log file backups:

•

•

Restore from incremental backups on page 16

•

Restore additional transaction log backups on page 17

If the restore is from the last full backup, refer to the section Restore from the last full backup on page
17 which outlines how to restore the full database (including associated transaction log files) backup.

Restore from a full backup
1. In the directory tree window, select the directory directly above the database backup.
For example a database residing on the G volume backed up on April 7, 2010 appears as a folder
named: G:\db\Exchange_Snap_07042010-0632-0486.
The G:\db folder would be selected (not marked).
2. From the View menu:
a. Select Versions.
b. Select the required version.
3. Click Change Browse Time.
4. In the directory tree window:
a. Navigate to the backup directory.
b. Mark the backup directory.
For example if the database backup resides on G:\db\ Exchange_Snap_<date>-<time>-<pid>\, mark
G:\db\ Exchange_Snap_<date>-<time>-<pid>\
Note: If the logs files for this database reside on the same volume, marking the
Exchange_Snap_<date>-<time>-<pid> directory will also mark the log files.
5. If the logs files for this database reside on a different volume:
a. Navigate to the volume in the directory tree that contains the log file backup.
b. Mark the directory. Log backups are also prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume D backed up on April 7, 2010 appears as a folder named
D:\logs\Exchange_Snap_07042010-0632-0487 and this folder would be marked for restore.
6. Click Recover.
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Restore from incremental backups
When restoring from an incremental backup, ensure that the database and its corresponding log file
backup has completed and then restore the additional transaction log files that were saved after the full
backup was performed.
To restore from an incremental backup:
1. Close the Restore Status window and then click Recover.
2. Select the Source client which is the Microsoft Exchange 2010 server and then click Ok.
3. Select the Destination client which is the Microsoft Exchange 2010 server and then click Ok.
4. From the Options menu, select Recover Options.
5. In the Relocate recovered data to field:
a. Type the original Microsoft Exchange 2010 directory.
b. If required, select Browse to navigate to the folder.
6. In the directory tree window, select the directory directly above the transaction log backup.
For example, if the transaction log backup resides on D:\logs\ Exchange_Snap_<date>-<time>-<pid>,
select (do not mark) G:\logs.
7. From the View menu:
a. Select Versions.
b. Select the required version.
8. Click Change Browse Time.
9. In the directory tree window:
a. Navigate to the backup directory.
b. Mark the backup directory.
10. Click Recover.
IMPORTANT: When restoring from an incremental backup, ensure that all of the incremental
backups are restored from the full backup that you are restoring from, up to and including the last
required transaction log file backup. Any gap in the transaction log sequence will stop the recovery at
the point of the highest uninterrupted log sequence.
11. Close the NetWorker User window when all restores have completed.
IMPORTANT: Once the recovery operation of the incremental backup begins, do not mount the database
until all of the logs and the databases have been recovered from the full and incremental backups that you
are restoring from. Attempting a parallel operation on a database while a recovery operation is in progress
might result in a -515 error. The database will need to be restored again, recovered, and then restarted.
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Restore additional transaction log backups
To restore additional transaction log backups:
1. Repeat the steps outlined in Restore from Incremental backups on page 16.
2. Close the NetWorker User window when all restores have completed.
Note: When multiple incremental transaction log backups are restored, the restore session might detect
that a l og f ile being r estored, a lready exists. T his m ight oc cur if s ome of t he t ransaction logs were n ot
purged i mmediately af ter t he bac kup and as a r esult ex ist i n m ultiple incremental backup s ets. I f t his
occurs, t he du plicates c an be d isregarded. M ultiple c opies of t he t ransaction logs ar e on ly included f or
safety purposes.
Restore from the last full backup
To restore from the last full backup:
1. Navigate to the volume where the database which is backed up resides. Database backups are
prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume G backed up on April 7, 2010 appears as a folder named
G:\db\Exchange_Snap_07042010-0632-0486
2. Mark this folder which in turn marks all of the subfolders.
3. Navigate to the volume where the transaction log files for the database reside.
Log backups are prefixed with Exchange_Snap_<date>-<time>-<pid>. For example a log file residing
on volume D backed up on April 7, 2010 appears as a folder named:
Exchange_Snap_07042010-0632-0487
4. Mark this folder which in turn marks all of the subfolders.
5. Click Recover.
6. Close the NetWorker User window when the recovery is complete.

Task 3: Extract the mailbox from the database
To extract the mailbox from the database:
1. Ensure that all required transaction logs have been restored using the NetWorker software. Any gap
in the transaction log sequence will stop the recovery at the point of the highest uninterrupted log
sequence.
From a command prompt, navigate to the directory that contains the recovered edb file. For example:
G:\recovery_edb
IMPORTANT: Once the eseutil program has completed, you cannot playback the transaction logs.
2. To automatically play back all of the available transaction logs found in log directory, apply the
restored Exchange transaction logs and put the recovered database in a clean shutdown state:
eseutil /R Exx /I /L <full path to log directory in restore folder> /D
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For example:
G:\RDB\db>eseutil /R E00 /I /L "G:\recovery_logs" /D
You can recover to a specific point in time by limiting the available transaction logs sequence.
Note: If the process fails with a -1216 error:
1. Perform an eseutil /P to repair the database.
2. Put the database into a consistent state.
3. Retry the clean shutdown.
IMPORTANT: Once started, do not interrupt the eseutil process or start other operations on the
database. Attempting a parallel operation on a database while a recovery is in progress might result in
a -515 error. The database will need to be restored again, recovered, and then restarted.
3. Confirm that the state of the database is “clean shutdown”:
eseutil /mh <filename.edb>
Where <filename.edb> is the name of the restored edb file.
For example:
G:\RDB\db>eseutil /mh "Mailbox Database 0829899187.edb"
4. Open up the Microsoft Exchange Management shell.
5. Run the following command to create a Recovery Database:
New-MailboxDatabase –Recovery -Name <RestoreDB> -Server <ServerName> EdbFilePath <path to edbfile.edb> –LogFolderPath <path to folder with
logfiles>”
Where:
•

<path to edbfile.edb> is the path to the directory that contains the database edb file.

•

<path to folder with logfiles> is the path to the folder where the restore was relocated to.

•

<RestoreDB> is a user defined name for the new restore database.

For example:
New-MailboxDatabase -Recovery -Name RDB -Server exch2010 -EdbFilePath
"G:\recovery_edb\Mailbox Database 0829899187.edb" -LogFolderPath
"G:\recovery_logs"
6. Mount the Recovery Database that you have just created:
Mount-Database –Identity <RestoreDB>
For example:
Mount-Database –Identity RDB
7. Allow restores to the original mailbox database:
Set-MailboxDatabase -AllowFileRestore:true
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8. If the mailbox that you are restoring to no longer exists, recreate a mailbox for the active directory
user:
Enable-Mailbox –Identity <user>
Note: For further details on the Enable-Mailbox command, refer to the following:
http://technet.microsoft.com/en-us/library/aa998251.aspx
9. Recover the single mailbox from the recovery database to a target mailbox in the active mailbox
database.
•

To restore the entire mailbox, overwrite the target mailbox:
Restore-Mailbox –Identity <mailboxname> –RecoveryDatabase <RestoreDB>
For example:
Restore-Mailbox -Identity e2k10\user1 -RecoveryDatabase RDB
IMPORTANT: If a mailbox was recreated for this user by using the enable-mailbox command,
this restore-mailbox command will fail due to a GUID mismatch.
Use this command to create a new subfolder in the user’s inbox for the restore mailbox items:
Restore-Mailbox -Identity <mailboxname> -RecoveryDatabase RestoreDB -TargetFolder
"Recovery".

•

To restore the entire mailbox, preserve the existing content and then direct the restored data to
the subfolder in the mailbox:
Restore-Mailbox -Identity <mailboxname> -RecoveryDatabase RestoreDB
-TargetFolder "Recovery".
For example:
Restore-Mailbox -Identity e2k10\user1 -RecoveryDatabase RDB
-TargetFolder "Recovery".

•

To restore a mailbox for a user into a subfolder of a different user’s mailbox:
Restore-Mailbox -Identity <mailboxname> -RecoverMailbox <targetmailbox>
-RecoveryDatabase RestoreDB -TargetFolder "<subfolder_name>"
For example:
Restore-Mailbox -Identity e2k10\user1 -RecoverMailbox e2k10\user2
-RecoveryDatabase RDB -TargetFolder "Recovery"

Note: http://technet.microsoft.com/en-us/library/bb125218.aspx provides other examples of restoremailbox use cases and parameters.
When the advanced Restore-Mailbox filters are used to search for specific mail items, some of the
most recent items might be missing from the restore. This occurs because the Microsoft Exchange
2010 server performs the indexing as a scheduled task and not in real-time. Examples of affected
filters include ContentKeywords and SubjectKeywords.
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10. When the restore has completed and it has been confirmed that the mailbox has restored correctly,
dismount:
Dismount-Database –Identity <RestoreDB>
For example:
Dismount-Database –Identity RDB
11. Delete the Recovery Database:
Remove-MailboxDatabase –Identity <RestoreDB>
Remove-MailboxDatabase –Identity RDB
12. If required, disallow restores to the mailbox databases:
Set-MailboxDatabase -AllowFileRestore:false
13. Delete the recover directory created.
The restore operation is complete.
Note: Only use the Recovery database to restore single items in the Mailbox databases. Microsoft does
not support using the Recovery database to restore Public folder databases.

How to perform a standalone server recovery (overwrite the original
database)
To recover a single mailbox, perform these tasks:
•

Task 1: Perform the standalone server recovery on page 20

•

Task 2: Perform a point-in-time or an incremental restore on page 21

•

Task 3: Complete the restore on page 24

Task 1: Perform the standalone server recovery
To perform a standalone server recovery:
1. Login to the Microsoft Exchange server with an account that has Organization Management rights in
Microsoft Exchange 2010.
Note: By default, the account that installed Microsoft Exchange 2010 is given Organization
Management rights. http://technet.microsoft.com/en-us/library/dd335087.aspx provides more
information on this right.
2. Open the Microsoft Exchange Management Console:
a. In the console tree, navigate to Organization Configuration > Mailbox.
b. In the result pane, select Database Management.
c. Right-click the database that you will be overwriting.
d. Click Properties.
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3. Under the Maintenance tab:
a. Ensure that the This database can be overwritten by a restore attribute has been selected and
then click Ok.
b. Right-click on the database that you will be overwriting and then select Dismount Database.
c. A warning appears asking if you want to dismount the database, select Yes.
4. Open the NetWorker User program on the Microsoft Exchange 2010 server:
a. Connect to the appropriate NetWorker server.
b. Click Recover.
c. Select the Source client which is the Microsoft Exchange 2010 server and then click Ok.
d. Select the Destination client which is the Microsoft Exchange 2010 server and then click Ok.
e. From the Options menu, select Recover Options.
f. In the Relocate recovered data to field, type the original directory of the Microsoft Exchange
2010. If required, select Browse to navigate to the folder.

Task 2: Perform a point-in-time or an incremental restore
This section explains how to:
•

Restore from a full backup on page 21

•

Restore from an incremental backups on page 22

•

Restore additional transaction log backups on page 23

•

Restore from last full backup on page 23

When restoring data from the NetWorker User program, by default, the last backup instances of the
databases and logs are shown:
•

If a point-in-time restore operation, or a restore from an incremental backup is required, the browse
time must be changed to mark the previous backup version.

•

If a point-in-time, or an incremental restore is required, refer to the following sections which outline
how to restore the full database (including associated transaction log files) and the subsequent
incremental transaction log file backups:

•

•

Restore from an incremental backups on page 22

•

Restore additional transaction log backups on page 23

If the restore is from the last full backup, refer to the section Restore from last full backup on page 23
which outlines how to restore the full database (including associated transaction log files) backup.
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Restore from a full backup
1. In the directory tree window, select the directory directly above the database backup.
For example a database residing on the G volume backed up on April 7, 2010 appears as a folder
named: G:\db\Exchange_Snap_07042010-0632-0486.
The G:\db folder would be selected (not marked).
2. From the View menu:
a. Select Versions.
b. Select the required version.
3. Click Change Browse Time.
4. In the directory tree window:
a. Navigate to the backup directory.
b. Mark the backup directory.
For example if the database backup resides on G:\db\ Exchange_Snap_<date>-<time>-<pid>\, mark
G:\db\ Exchange_Snap_<date>-<time>-<pid>\
Note: If the logs files for this database reside on the same volume, marking the
Exchange_Snap_<date>-<time>-<pid> directory will also mark the log files.
5. If the logs files for this database reside on a different volume:
a. Navigate to the volume in the directory tree that contains the log file backup.
b. Mark the directory. Log backups are also prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume D backed up on April 7, 2010 appears as a folder named
D:\logs\Exchange_Snap_07042010-0632-0487 and this folder would be marked for restore.
6. Click Recover.
Restore from an incremental backups
When restoring from an incremental backup, ensure that the database and its corresponding log file
backup has completed and then restore the additional transaction log files that were saved after the full
backup was performed.
To restore from an incremental backup:
1. Close the Restore Status window and then click Recover.
2. Select the Source client which is the Microsoft Exchange 2010 server and then click Ok.
3. Select the Destination client which is the Microsoft Exchange 2010 server and then click Ok.
4. From the Options menu, select Recover Options.
5. In the Relocate recovered data to field:
a. Type the original Microsoft Exchange 2010 directory.
b. If required, select Browse to navigate to the folder.
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6. In the directory tree window, select the directory directly above the transaction log backup.
For example, if the transaction log backup resides on D:\logs\ Exchange_Snap_<date>-<time>-<pid>,
select (do not mark) G:\logs.
7. From the View menu:
a. Select Versions.
b. Select the required version.
8. Click Change Browse Time.
9. In the directory tree window:
a. Navigate to the transaction log backup directory.
b. Mark the transaction log backup directory.
10. Click Recover.
IMPORTANT: When restoring from an incremental backup, ensure that all of the incremental backups
are restored from the full backup that you are restoring from, up to and including the last desired
transaction log file backup. Any gap in the transaction log sequence will stop the recovery at the point of
the highest uninterrupted log sequence.
Restore additional transaction log backups
1. To restore additional transaction log backups, repeat the steps outlined in Restore from an
incremental backups on page 22.
2. Close the NetWorker User window when all restores have completed.
Note: When multiple incremental transaction log backups are restored, the restore session might detect
that a l og f ile being r estored, a lready exists. T his m ight oc cur if s ome of t he t ransaction logs were n ot
purged i mmediately af ter t he bac kup and as a r esult ex ist i n m ultiple incremental backup s ets. I f t his
occurs, t he du plicates c an be d isregarded. M ultiple c opies of t he t ransaction logs ar e on ly included f or
safety purposes.
Restore from last full backup
To restore from the last full backup:
1. Navigate to the volume where the database which is backed up resides. Database backups are
prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume G backed up on April 7, 2010 appears as a folder named
G:\db\Exchange_Snap_07042010-0632-0486
2. Mark this folder which in turn marks all of the subfolders.
3. Navigate to the volume where the transaction log files for the database reside. Log backups are
prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume D backed up on April 7, 2010 appears as a folder named
Exchange_Snap_07042010-0632-0487
4. Mark this folder which in turn marks all of the subfolders.
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5. Click Recover.
6. Close the NetWorker User window when the recovery is complete.

Task 3: Complete the restore
To complete the restore:
1. From a command prompt, navigate to the directory that contains the recovered edb file. For example:
G:\recovery_edb.
IMPORTANT: Once the eseutil program has completed, you cannot playback the transaction logs.
2. To automatically play back all of the available transaction logs found in log directory, apply the
restored Microsoft Exchange transaction logs and put the recovered database in a clean shutdown
state:
eseutil /R Exx /I /L <full path to log directory in restore folder> /D
For example:
G:\RDB\db>eseutil /R E00 /I /L "G:\recovery_logs" /D
You can recover to a specific point in time by limiting the available transaction logs sequence.
Note: If the process fails with a -1216 error:
1. Perform an eseutil /P to repair the database.
2. Put the database into a consistent state.
3. Retry the clean shutdown.
Note: Once started, do not interrupt the eseutil process or start other operations on the database.
Attempting a parallel operation on a database while a recovery is in progress might result in a -515
error. The database will need to be restored again, recovered, and then restarted.
3. From a command prompt:
a. Navigate to the directory that contains the edb file for the recovered database.
b. Run the following command to confirm that the state is “clean shutdown”:
eseutil /mh <filename.edb>
Where <filename.edb> is the actual name of the restored edb file.
For example:
eseutil /mh "Mailbox Database 0829899187.edb"
4. In the Microsoft Exchange Management Console:
a. Right-click on the database.
b. Select Mount Database.
The restore operation is complete.
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How to perform a DAG recovery (overwrite the original database)
To perform a DAG recover (overwrite the original database), perform these tasks:
•

Task 1: Perform the recovery from the DAG active copy on page 25

•

Task 2: Perform a point-in-time or an incremental restore on page 26

•

Task 3: Complete the restore on page 29

Task 1: Perform the recovery from the DAG active copy
To perform a DAG recovery:
1. Perform the recovery from the DAG active copy. If required, failover the passive copy to the active
copy.
Note: In the DAG setup, you can only recover to the active copy. Recovery is not possible for
passive copies.
2. Login to the Microsoft Exchange server where the DAG mailbox active copies reside. Use an account
that has Organization Management rights in Microsoft Exchange 2010.
Note: By default, the account that installed Microsoft Exchange 2010 is given Organization
Management rights. http://technet.microsoft.com/en-us/library/dd335087.aspx provides more
information.
3. Open the Microsoft Exchange Management Console.
a. In the console tree, navigate to Organization Configuration > Mailbox.
b. In the result pane, select the Database Management tab.
c. Right-click the database that you will be overwriting.
d. Click Properties.
4. Under the Maintenance tab:
a. Ensure that the This database can be overwritten by a restore attribute has been selected.
b. Click Ok.
5. In the Microsoft Exchange command shell, use the following command to stop replication to the
passive copy:
Suspend-MailboxDatabaseCopy
For example:
Suspend-MailboxDatabaseCopy -Identity DB1\MBX3 -SuspendComment "Maintenance
on EXMBX3" -Confirm:$false
6. Right-click on the database that you will be overwriting and then select Dismount Database.
7. A warning appears asking if you want to dismount the database, click Yes.
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8. Open the NetWorker User program on the Microsoft Exchange 2010 server:
a. Connect to the appropriate NetWorker server.
b. Click Recover.
c. Select the source client which is the Microsoft Exchange 2010 server and then click Ok.
d. Select the destination client which is the Microsoft Exchange 2010 server and then click Ok.
e. From the Options menu, select Recover Options.
f. In the Relocate recovered data to field, type the original directory of the Microsoft Exchange
2010. If required, select Browse to navigate to the folder.

Task 2: Perform a point-in-time or an incremental restore
This section explains how to:
•

Restore from a full backup on page 26

•

Restore from incremental backups on page 27

•

Restore additional transaction log backups on page 28

•

Restore from the last full backup on page 28

When restoring data from the NetWorker User program, by default, the last backup instances of the
databases and logs are shown:
•

If a point-in-time restore operation, or a restore from an incremental backup is required, the browse
time must be changed to mark the previous backup version.

•

If a point-in-time, or an incremental restore is required, refer to the following sections which outline
how to restore the full database (including associated transaction log files) and the subsequent
incremental transaction log file backups:

•

•

Restore from incremental backups on page 27

•

Restore additional transaction log backups on page 28

If the restore is from the last full backup, refer to the section Restore from the last full backup on page
28 which outlines how to restore the full database (including associated transaction log files) backup.

Restore from a full backup
To restore from a full backup:
1. In the directory tree window, select the directory directly above the database backup.
For example a database residing on the G volume backed up on April 7, 2010 appears as a folder
named: G:\db\Exchange_Snap_07042010-0632-0486.
The G:\db folder would be selected (not marked).
2. From the View menu:
a. Select Versions.
b. Select the required version.
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3. Click Change Browse Time.
4. In the directory tree window:
a. Navigate to the backup directory.
b. Mark the backup directory.
For example if the database backup resides on G:\db\ Exchange_Snap_<date>-<time>-<pid>\, mark
G:\db\ Exchange_Snap_<date>-<time>-<pid>\
Note: If the logs files for this database reside on the same volume, marking the
Exchange_Snap_<date>-<time>-<pid> directory will also mark the log files.
5. If the logs files for this database reside on a different volume:
a. Navigate to the volume in the directory tree that contains the log file backup.
b. Mark the directory. Log backups are also prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume D backed up on April 7, 2010 appears as a folder named
D:\logs\Exchange_Snap_07042010-0632-0487 and this folder would be marked for restore.
6. Click Recover.
Restore from incremental backups
When restoring from an incremental backup, ensure that the database and its corresponding log file
backup has completed and then restore the additional transaction log files that were saved after the full
backup was performed.
To restore from an incremental backup:
1. Close the Restore Status window and then click Recover.
2. Select the Source client which is the Microsoft Exchange 2010 server and then click Ok.
3. Select the Destination client which is the Microsoft Exchange 2010 server and then click Ok.
4. From the Options menu, select Recover Options.
5. In the Relocate recovered data to field:
a. Type the original Microsoft Exchange 2010 directory.
b. If required, select Browse to navigate to the folder.
6. In the directory tree window, select the directory directly above the transaction log backup.
For example, if the transaction log backup resides on D:\logs\ Exchange_Snap_<date>-<time>-<pid>,
select (do not mark) G:\logs.
7. From the View menu:
a. Select Versions.
b. Select the required version.
8. Click Change Browse Time.
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9. In the directory tree window:
a. Navigate to the transaction log backup directory.
b. Mark the directory.
10. Click Recover.
IMPORTANT: When restoring from an incremental backup, ensure that all of the incremental
backups are restored from the full backup that you are restoring from, up to and including the last
desired transaction log file backup. Any gap in the transaction log sequence will stop the recovery at
the point of the highest uninterrupted log sequence.
Restore additional transaction log backups
1. To restore additional transaction log backups, repeat the steps outlined in Restore from incremental
backups on page 27.
2. Close the NetWorker User window when all restores have completed.
Note: When multiple incremental transaction log backups are restored, the restore session might detect
that a l og f ile being r estored, a lready exists. T his m ight oc cur if s ome of t he t ransaction logs were n ot
purged i mmediately af ter t he bac kup and as a r esult ex ist i n m ultiple incremental backup s ets. I f t his
occurs, t he du plicates c an be d isregarded. M ultiple copies of t he t ransaction logs ar e on ly included f or
safety purposes.
Restore from the last full backup
To restore from the last full backup:
1. Navigate to the volume where the database which is backed up resides.
Database backups are prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume G backed up on April 7, 2010 appears as a folder named
G:\db\Exchange_Snap_07042010-0632-0486
2. Mark this folder which in turn marks all of the subfolders.
3. Navigate to the volume where the transaction log files for the database reside.
Log backups are prefixed with Exchange_Snap_<date>-<time>-<pid>.
For example a log file residing on volume D backed up on April 7, 2010 appears as a folder named
Exchange_Snap_07042010-0632-0487
4. Mark this folder which in turn marks all of the subfolders.
5. Click Recover.
6. Close the NetWorker User window when the recovery is complete.
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Task 3: Complete the restore
To complete the restore:
1. Open the Microsoft Exchange server where the active mailbox database copies reside.
2. From a command prompt, navigate to the directory that contains the recovered edb file.
For example:
G:\recovery_edb
3. To automatically play back all of the available transaction logs found in log directory, apply the
restored Microsoft Exchange transaction logs and put the recovered database in a clean shutdown
state:
eseutil /R Exx /I /L <full path to log directory in restore folder> /D
For example:
G:\RDB\db>eseutil /R E00 /I /L "G:\recovery_logs" /D
You can recover to specific point in time by limiting the available transaction logs sequence.
Note: If the process fails with a -1216 error:
1. Perform an eseutil /P to repair the database.
2. Put the database into a consistent state.
3. Retry the clean shutdown.
Note: Once started, do not interrupt the eseutil process or start other operations on the database.
Attempting a parallel operation on a database while a recovery is in progress will result in a -515
error. The database will need to be restored again, recovered, and then restarted.
4. From a command prompt:
a. Navigate to the directory that contains the edb file for the recovered database.
b. Run the following command to confirm that the state is “clean shutdown”:
eseutil /mh <filename.edb>
Where <filename.edb> is the actual name of the restored edb file.
For example:
G:\RDB\db>eseutil /mh "Mailbox Database 0829899187.edb"
5. In the Microsoft Exchange Management Console:
a. Right-click on the database.
b. Select Mount Database.
6. Open the Microsoft Exchange server where the passive copies reside.
7. Manually delete the following:
•

Log files

•

The database file for the Mailbox database
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8. Open the Microsoft Exchange command shell, use the Update-MailboxDatabaseCopy command to
reseed the passive mailbox database copies.
For example:
Update-MailboxDatabaseCopy -Identity DB1\MBX1 -SourceServer MBX2
9. Where MBX2 is the Microsoft Exchange Server where the active mailbox database copies reside.
The restore operation is complete.
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